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Introduction to Voice-Based Systems
In today's world, businesses face multiple challenges. Supply chains are becoming bigger, more complex, 
and time critical. Businesses continuously strive to keep pace with increasing customer demands, while 
keeping their operating costs low. These challenges apply to warehouses that are an integral part of the 
supply chain as well. An efficient warehouse management system enables a business to achieve better 
productivity. Many businesses have now recognized the benefits of using voice technology for 
warehouse-related tasks such as picking, replenishment, and putaway.

A voice-based system includes a mobile headset unit that can be used by warehouse users. These users do 
not have to hold a bar code scanner to perform picking activity, and do not have to take their eyes off the 
task they are performing to read the system prompts that appear on the barcode screen. This translates to 
immediate time and productivity gains in the overall warehouse process.

Users can not only receive voice instructions, but can also confirm their actions back to the system orally. 
A primary advantage of voice-based systems is the short training period associated with learning how to 
operate them. Additionally, users can send and receive instructions in their native language. Voice-based 
systems also increase accuracy because of real-time communication. They are ideal for use in locations with 
freezers, where users wear gloves and find it difficult to carry the bar code scanner in their hands. It is also 
ideal for use in high-rise locations because users’ hands remain free, improving their accuracy and 
productivity.

Understanding Voice-Based Picking

Picking activity, which was traditionally performed using either papers or a radio frequency (RF) mobile 
device, can now be performed using voice technology. A warehouse user no longer has to read the 
instructions from either a paper or an RF device. Instead, the user wears a headset with an attached 
microphone, and listens to the picking instructions given by the system in the form of voice prompts.

A user receives a voice prompt from the system about the source location to visit, the number of items to 
pick from that location, and the destination at which to deposit the picked items. Accordingly, the user visits 
the corresponding location, performs the picking task, and deposits the picked items. After the task is 
completed, the user orally confirms to the system that the action is completed. This serves as an indicator to 
the system that the next picking task can be assigned to the user.

In order to enable voice-based picking activity in a warehouse, and ensure user safety, the Sterling 
Warehouse ManagementTM System has integrated with Voxware's VoiceLogistics ProTM (VLP).

Advantages of VoiceLogistics Pro

The Sterling Warehouse Management System supports voice-based picking by integrating with Voxware's 
VoiceLogistics Pro, which provides user-defined, customizable workflows that match individual business 
requirements.

Following are some of the advantages of integrating the Sterling Warehouse Management System with 
Voxware:

✦ Voxware provides voice-driven software products that optimize the full spectrum of warehouse 
operations for greater accuracy, productivity, and flexibility in supply chain execution.
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✦ Voxware provides a powerful suite of tools that can be used to design and implement voice-enabled 
warehouse and distribution center logistic solutions that manage activities such as picking, receiving, 
and replenishment. 

✦ Voxware combines configurable solutions with voice-enabled technology to improve the productivity 
and accuracy of a warehouse.
Sterling Commerce, Inc. 6



Stack for Installing the Sterling-VoiceLogistics Pro Integration 
Pack
The Sterling-VoiceLogistics Pro integration pack is supported on the following stack:

✦ Database server - Oracle® 9i and later.

✦ Application server - Apache TomcatTM 5.0.

✦ Operating system - Windows® Server 2003

✦ JavaTM plug-in - JDK 1.5

Prerequisites for the Sterling-VoiceLogistics Pro Integration Pack
The Sterling-VoiceLogistics Pro integration pack is certified on VLP 2.1.3.5. 

Notes:

✦ VLP is not bundled with the Sterling Warehouse Management System. Install VLP on your system 
using the instructions provided in the VLP Bookshelf Guide.

✦ Ensure that you have the Sterling Warehouse Management System, version 8.5, installed on your 
system.

✦ By default, VLP installs and points to JDK 1.4.2, which is installed as part of VLP installation. For the 
Sterling-VoiceLogistics Pro integration pack, point the environment to either JRE 1.5 or to a later 
version. For the Sterling-VoiceLogistics Pro integration pack, the environment variable JAVA_HOME 
should point to JDK 1.5.

✦ Ensure that you have performed the following tasks:
a. Navigate to the <VOX_HOME>/vlp_core/src/voxconnect_ext directory path
b. Open the build.xml file
c. Go to target voxconnectextensions 
d. add source parameter in javac task as: 
e. <javac destdir="${build}" debug="true" debuglevel="lines,vars,source" 

source="1.4">

✦ When configuring the Tomcat service properties, navigate to the Java tab, configure the Java Virtual 
Machine (JVM) parameter to point to JDK 1.5, and under Java Options, add the following properties 
as shown in the image that follows: Also ensure that your environment variable points to JDK 1.5.

-DvendorFile=/servers.properties
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-Dvendor=shell
Sterling Commerce, Inc. 8



Install the Sterling-VoiceLogistics Pro Integration Pack
Perform the following steps to install the Sterling-VoiceLogistics Pro (VLP) integration pack:

1. Place the Sterling Warehouse Management System, version 8.5, installation CD in the appropriate 
drive.

2. From the installation CD, copy the WMS_Add-in.jar file, and unzip it to a temporary folder.
3. Copy the SterlingVoxwareIntegrationPack.zip file to a new folder in the machine where the 

VLP is installed.
4. Unzip the SterlingVoxwareIntegrationPack.zip file in this folder.
5. Save the ynw_vox_variable.properties.sample file as ynw_vox_variable.properties.
6. Open the /resources/ynw_vox_variable.properties file in any text editor, such as the 

Notepad, and perform the following tasks:

Set the value of the voxhome property to the path of the VLP’s installation folder.

Set the value of the ynw.voxware.dbtype property to the database type used by VLP, for 
example, if VLP is installed in Oracle, set it to oracle.

Set the value of the ynw.voxware.dbdriver property to the database driver’s classname in 
order to connect it to the VLP database, for example, 
ynw.voxware.dbdriver=oracle.jdbc.OracleDriver

Set the value of the ynw.voxware.dbjar property to the driver jar or zip to connect it to the VLP 
database, for example, 
ynw.voxware.dbjar=c\:/sterling/dbjar/jdbc/Oracle/ojdbc14.jar

Set the value of the ynw.voxware.dbPool.url property to the connection URL to connect it to 
the VLP database, for example, 
ynw.voxware.dbPool.url=jdbc:oracle:thin:@10.11.20.80:1521:orcl

Set the value of the ynw.common.folder.root property to the same folder path that is specified 
in the Completion Directory property of the File I/O component in the data upload services, as 
described in the topic on Configure Data Upload and Import Services. 
If it is a network path, the property should be configured as follows:
ynw.common.folder.root=\\\\<root>\\VoicePicking\\Completed

If it is an absolute path, the property should be configured as follows:
ynw.common.folder.root=c\:/VoicePicking/Completed

Set the value of the ynw.move.folder.root property to a folder path to which the data upload files 
are to be moved after data import is complete from VLP side.
If it is a network path, the property should be configured as follows:
ynw.move.folder.root=\\\\<root>\\VoicePicking\\Done

If it is an absolute path, the property should be configured as follows:
ynw.move.folder.root=c\:/VoicePicking/Done

7. Open the /resources/yifclient.properties file and set the following values:
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yif.apifactory.protocol=HTTP

yif.httpapi.url=http://<hostname>:<portnumber>/smcfs/interop/VoiceInteropHttpServlet

In this instance,
– hostname is the computer name or IP address of the computer where the Sterling Warehouse 
Management System is installed.
– portnumber is the listening port of the computer where the Sterling Warehouse Management 
System is installed.

Note: For more information about how to configure a secured communication between the Sterling 
Warehouse Management System and VLP, refer to the topic Security for Voice Integration

8. Execute the following command in the folder in which the 
SterlingVoxwareIntegrationPack.zip file was unzipped:
ant -f ynw_voxware_installer.xml
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Deploy the Sterling Picking Workflow
Perform the following steps to deploy the Sterling Picking workflow:

1. Open Voxware’s VoxStudio using the default user name SUPERVISOR and default password 
voxware. 

2. The VoxStudio user interface is displayed. From the menu bar, navigate to File > Open Workflow 
Group.

3. The Create dialog box is displayed. Browse to 
<voxhome>/SterlingPickingWorkflow\workflow\STERLING_VOICE_WORKFLOWS, select 
STERLING_VOICE_WORKFLOWS.wsf from the list, and click Open.

4. The PICKING workflow is displayed in the VoxStudio workspace. From the Languages panel of the 
PICKING workflow, select the American English check box, and navigate to File > Save Workflow 
Group.
Note:
Only the English language is supported for the out-of-the-box PICKING workflow. Localization to 
other language will require customization. For more information about customization, please contact 
Sterling Customer Support.

5. From the VoxStudio menu bar, navigate to Edit > Grammar. The Languages dialog box is displayed. 
Select a language from the drop-down list, and click OK.

6. The editing window opens. Remove the contents of this file, paste the contents of the 
DemoPicking.grm file into this file, and save the file.
Notes:

The DemoPicking.grm file is provided by Sterling Warehouse Management System for defining 
the grammar for the PICKING workflow. This file is present in the 
<voxhome>/SterlingPickingWorkflow/grammar folder.

Out-of-the-box, the grammar file supports only numeric strings or digits for CaseID, PalletID, 
SerialNo, Tag Attributes, Zone Check Digit, Equipment Check, and Task Type ID. Grammar can 
be customized to support alpha-numeric values. In order to do so, please contact Sterling Customer 
Support.

7. From the VoxStudio menu bar, navigate to File > Deploy.
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8. The Deploy Options dialog box is displayed. Select the Workflow Changes, New User Exits or 
Conditions, and the Restart Tomcat Service check boxes, and click Deploy.
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Configure Data Upload and Import Services
In order to execute workflows, VoiceLogistics Pro (VLP) must possess certain details about the Sterling 
Warehouse Management System’s configuration, for example, the warehouse, the locations and zones, the 
users of the warehouse, and the equipments being used. This chapter describes the steps involved in 
synchronizing data between the Sterling Warehouse Management System and its associated voice instance.

The configuration data is transferred from the Sterling Warehouse Management System to VLP using XML 
files. Both the Sterling Warehouse Management System and the corresponding VLP instances must have 
access to the common folder containing these XML files.

Details pertaining to the following are required for voice-based task execution:

✦ Ship Node
✦ Zone
✦ Location
✦ Task Type
✦ Equipment
✦ Execution Exception
✦ Item
Data synchronization between the Sterling Warehouse Management System and VLP is based on a shared 
folder mechanism and involves the following steps:

1. Uploading the Sterling Warehouse Management System configuration data as XML files to the shared 
folder.

2. Importing (reading) the XML file from the shared folder to VLP.

Upload the Sterling Warehouse Management System Configuration 
Data as XML Files

The Sterling Warehouse Management System provides data upload services for each configuration data 
entity. Each service extracts the Sterling Warehouse Management System configuration data, converts it to 
a data format that is understood by VLP, and uploads the data as an XML file to a shared folder. 

Data Upload Mechanism

All the upload services have a common structure, and are asynchronous services. The following figure 
illustrates a typical service.
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Each upload service consists of the following components:

✦ JMS
✦ XSL Translator
✦ Text Translator and File I/O
The data is first sent to the JMS queue as a request in the Sterling XML format. The data that is posted to 
the queue is controlled by a template that is provided out-of-the-box by the Sterling Warehouse 
Management System.

A common integration server is configured for these services, which picks up the request from the JMS 
queue, and passes it to the XSL Translator. This Translator converts the data to VLP XML format. Finally, 
the Text Translator and the File I/O Components write the data to an XML file in the common shared folder.

Data Upload Services

The Sterling Warehouse Management System provides the following out-of-the-box data upload services:

✦ YNW_ShipNodeDataExporter_85
✦ YNW_ ZoneDataExporter_85
✦ YNW_ LocationDataExporter_85
✦ YNW_ TaskTypeDataExporter_85
✦ YNW_ EquipmentDataExporter_85
✦ YNW_ExecutionExceptionDataExporter_85
✦ YNW_ ItemDataExporter_85
To view these data upload services, perform these steps:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Application 
Platform.

2. From the tree in the application rules side panel, double-click Process Modeling. 
3. The Process Modeling window (shown is the following figure) is displayed. Click the General tab. 

This displays the hierarchy of the document and process types. 
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4. Double-click Task Execution. 
This displays the transactions in the application rules side panel.

5. In the Activity icons panel displayed at the bottom of the application rules side panel, click . 
The task execution services are displayed in the applications rule side panel. 

6. From the tree in the application rules side panel, click  or double-click VoxwareIntegration. 
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7. The tree is expanded as shown in the following figure. Double-click the data upload service whose 
details you want to view.

The out-of-the-box data load services provided by the Sterling Warehouse Management System are system 
defined, and cannot be modified. Users must use these services as templates, and create new services using 
the Save As option. After the new service is created, associate it to the configured voice application instance. 
For more information about how to Save As a service, refer to the Selling and Fulfillment Foundation: 
Application Platform Configuration Guide. To create the new services, set the following properties:

✦ JMS Component - This component has two sub-components, JMS Sender and JMS Receiver. 
Note: You can modify the integration server that is configured with the JMS Receiver (placed under 
the Server tab that is displayed when the JMS Receiver is selected).

✦ XSL Translator - The XSL name is provided out-of-the-box. You should not modify this unless they 
intend to customize the data.

✦ Text Translator and File I/O Component - These two components are connected by the File I/O Sender 
Component. Set the following properties for the File I/O Sender Component:

Working Directory - The folder that is used by the data upload service while writing the XML file.

Completion Directory - The completed XML files are placed in this directory. This directory 
should be the common, shared directory that is accessed by both the Sterling Warehouse 
Management System and VLP.

Note: These properties have to be set for all the data upload services.
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Import XML Files to VoiceLogistics Pro
The data upload services of the Sterling Warehouse Management System write data in VLP-compatible 
XMLs. VLP provides data import events that read the XML files and load them into the VLP database, for 
example, VLP_ZONE_LOAD (Import Zone), that is used to import data pertaining to zones.

All the required VLP data import events are associated to the Sterling Local XML Reader transports, that 
are provided as part of the Sterling-VoiceLogistics Pro integration pack. 

The underlying transport type imports the XML files to VLP in the following manner:

1. Reads the configuration data XML from the common shared folder.
2. Creates the VLPMessage Java object from these XMLs.
3. Uses this Java object to load the data into VLP tables.
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Configuring a Voice Application
Voice application refers to an external voice solution provider used for the voice pick operation.

Create a Voice Application
Perform the following steps to create a voice application:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications.

4. The Voice Applications panel is displayed. Click .
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5. The Voice Application Details dialog box is displayed. Enter information in the applicable fields, and 

click .

The following table describes the fields in the Voice Application Details dialog box.

Note: An out-of-the-box voice application, VOXWARE, is provided in the Sterling Warehouse 
Management System Applications Manager. It is recommended that users use this voice application 
because all the integration parameters that are required for integration with the Sterling Warehouse 
Management System are provided with this out-of-the-box voice application.

View Voice Application Details
Perform the following steps to view the details pertaining to the voice application:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 

Field Description

Voice Application Mandatory. Enter the name of the external voice solution provider.

Description Enter a brief description of the voice application.
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4. The Voice Applications panel is displayed. From the list that is displayed in this panel, double-click the 
voice application whose details you want to view.

The Voice Application Details dialog box is displayed.
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The following table describes the fields in the Voice Application Details dialog box.

The following table describes the fields in the Voice Application Instance tab in the Voice Application 
Details dialog box. 

Note: Multiple voice instances can be defined for a voice application.

The following table describes the fields in the Voice Work Flow tab in the Voice Application Details dialog 
box. 

Note: Multiple workflows can be defined for a voice application.

Modify a Voice Application
Perform the following steps to modify a voice application:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications.
4. The Voice Applications panel is displayed. From the list that is displayed in this panel, select the voice 

application whose information you want to modify, and click .

5. The Voice Application Details dialog box is displayed. Make the necessary changes, and click .

Field Description

Voice Application Displays the voiceapplication name.

Description Displays the description of the voice application.

Field Description

Instance ID Displays the identifier of the instance of the selected voice application.

Description Displays the description of the voice application instance.

Field Description

Workflow ID Displays the identifier pertaining to the workflow of the selected voice application.

Description Displays the description of the voice workflow.
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Delete a Voice Application
Note that the VOXWARE voice application that is system defined cannot be deleted.

Perform the following steps to delete a voice application:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management System.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. From the list displayed in this panel, select the voice 

application that you want to delete, and click .
5. A confirmation dialog box is displayed. Select OK to confirm the deletion of the voice application.
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Configuring a Voice Application Instance
A voice application instance represents the server that hosts the external voice application. Multiple 
instances can be defined for a voice application. However, only one instance can be associated with a ship 
node.

Create a Voice Application Instance
Perform the following steps to create a voice application instance:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent to Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. From the list that is displayed in this panel, double-click the 

voice application for which you want to create an instance.
5. The Voice Application Details dialog box is displayed. Click the Voice Application Instance tab. 

6. In the Voice Application Instance panel, click .

7. The Voice Application Instance Details dialog box is displayed. Enter information in the applicable 

fields, and click .
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The following table describes the fields in the Voice Application Instance Details dialog box.

The Integration Attributes panel in the Voice Application Instance Details dialog box helps you to define 
the various parameters that are required for a voice instance to integrate with the external voice solution 
providers.

The following table describes the fields in the Integration Attributes panel of the Voice Application Instance 
Details dialog box.

Note: If you are setting instance attributes for the predefined VOXWARE voice application, note that all 
the data load services for VoiceLogistics Pro are provided out-of-the-box in this integration. 
However, a user can override the out-of-the-box data load service with custom service.

Field Description

Voice Application Displays the identifier of the selected voice application for which you are creating a voice 
application instance.

Voice Application 
Instance

Mandatory. Enter a name for the voice application instance that you are creating.

Description Enter a brief description of the voice application instance.

Field Description

Parameter Name Enter a name for the integration parameter.

Parameter Value Enter a value for the integration parameter.
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If you are working with the out-of-the-box VOXWARE voice application, the integration parameters, as 
displayed in the following figure, are provided. The values of these parameters should be configured 
appropriately.

The following table describes the fields in the Integration Attributes panel of the Voice Application Instance 
Details dialog box.

Parameter Name Parameter Value (Default) Description

WMSShipNodeDataUploadService YNW_ShipNodeDataExporter_85 The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
ship node.

WMSZoneDataUploadService YNW_ZoneDataExporter_85 The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
ship zone.

WMSTaskTypeUploadService YNW_TaskTypeDataExporter_85 The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
task type.

WMSLocationUploadService YNW_LocationDataExporter_85 The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
location.
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Note: When you select a Parameter Name field, the corresponding Parameter Value field gets activated. 
Continue this process of associating Parameter Names with Parameter Values depending on the 
number of integration attributes you want to set for a voice instance.

Modify a Voice Application Instance
Perform the following steps to modify a voice application instance:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications window is displayed. Double-click the voice application that contains the 

instance information that you want to modify. 

WMSEquipmentUploadService YNW_EquipmentDataExporter_85 The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
equipment.

WMSExecutionExceptionUploadServ
ice

YNW_ExecutionExceptionDataExpor
ter_85

The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
execution exception reason code.

WMSItemUploadService YNW_ItemDataExporter_85 The service that is used for uploading 
the changes pertaining to the Sterling 
Warehouse Management System 
item.

DataTemplateDirectory /template/voicePicking/voxware/entit
yTemplate/

This directory contains the templates 
that are required for data uploads.
Note: For more information about 
data upload services, refer to the 
topic Configure Data Upload and 
Import Services

SecurityPolicy NONE or CALLBACK This policy is used for securing the 
communication between the Sterling 
Warehouse Management System 
and VLP. For more information about 
security policy, refer to the topic 
Configuring a Voice Application 
Instance.

VoxwareServer http://<VLP URL>:<VLP 
Port>/ngv/workflow/wmsrequest

This parameter is applicable only 
when the security policy is configured 
as CALLBACK.

Parameter Name Parameter Value (Default) Description
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5. The Voice Application Details dialog box is displayed. Click the Voice Application Instance tab. 
6. The Voice Application Instance panel is displayed. From the list displayed in this panel, select the 

instance whose information you want to modify, and click . 
7. The Voice Application Instance Details dialog box is displayed. Make the necessary changes, and click 

.

Delete a Voice Application Instance
Perform the following steps to delete a voice application instance:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. Double-click the voice application that contains the 

instance that you want to delete.
5. The Voice Application Details dialog box is displayed. Click the Voice Application Instance tab. 
6. The Voice Application Instance panel is displayed. Select the instance that you want to delete, and 

click .
7. A confirmation dialog box is displayed. Select OK to confirm the deletion of the instance.

Delete the Integration Attributes of a Voice Application Instance
Perform the following steps to delete the integration attributes of a voice application instance:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. Double-click the voice application that contains the 

instance whose integration attributes you want to delete.
5. The Voice Application Details dialog box is displayed. Click the Voice Application Instance tab.
6. The Voice Application Instance panel is displayed. Double-click the instance for which you want to 

delete the integration attributes.
7. The Voice Application Instance Details dialog box is displayed. Select the integration attribute that you 

want to delete, and click . 
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8. A confirmation dialog box is displayed. Select OK to confirm the deletion of the integration attribute, 

and click .
Note: System-defined attributes cannot be deleted by a user. Only the attributes defined by the user can be 

deleted.
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Configuring a Voice Workflow
A voice workflow represents a series of activities and voice-based dialogs required to manage and control 
the business processes of an external voice application.

Note: A workflow can be associated to multiple activity groups and activity codes.

Create a New Voice Workflow
Perform the following steps to create a new voice workflow:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications window is displayed. Double-click the voice application for which you want to 

create a workflow.
5. The Voice Application Details dialog box is displayed. Click the Voice Work Flow tab.

6. The Voice Work Flow panel is displayed. Click . 
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7. The Voice Work Flow Details dialog box is displayed. Enter information in the applicable fields, and 

click .

The following table describes the fields in the Voice Work Flow Details dialog box.

Field Description

Voice Application Displays the identifier of the selected voice application for which you are creating a voice 
workflow.

Workflow ID Mandatory. Enter the name of the voice workflow that you are creating.
Note: The Workflow ID that you enter should be the same as the Workflow ID defined in 
VoiceLogistics Pro.

Description Enter a brief description of the voice workflow.
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The Workflow Activity Association panel in the Voice Work Flow Details dialog box helps you associate 
activity groups and activity codes with the workflow.

The following table describes the Workflow Activity Association panel of the Voice Work Flow Details 
dialog box.

Note:

For the PICKING workflow in VoiceLogistics Pro, a predefined Voice Work Flow called 
PICKING is provided under the VOXWARE voice application in the Sterling Warehouse 
Management System Applications Manager. This PICKING workflow is associated with the 
Outbound Picking activity group and Order Pick activity code.

When the Activity Code field is selected, the corresponding Activity Group ID field gets activated. 
Continue this process of associating the Activity Group IDs with the Activity Codes depending on 
the Voice Work Flow configured. This association enables a user to associate task types with the 
workflow during task-type execution. For more information about this association, refer to the 
topic Associate a Task Type with a Voice Workflow.

Field Description

Activity Group ID Mandatory. Select the appropriate Activity Group ID from the drop-down list.

Activity Code Select an activity code for the Activity Group ID from the drop-down list.
Note: Only those activity codes that are associated with the selected activity group will 
be populated in this drop-down list.
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View a Voice Workflow
Perform the following steps to view a voice workflow:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications window is displayed. Double-click the voice application that contains the 

voice work flow whose details you want to view.
5. The Voice Application Details dialog box is displayed. Click the Voice Work Flow tab.
6. The Voice Work Flow panel is displayed. Double-click the Workflow ID whose details you want to 

view. 
The Voice Work Flow Details dialog box is displayed.

The following table describes the fields in the Voice Work Flow Details dialog box.

Field Description

Voice Application Displays the identifier of the selected voice application, whose voice work flow details 
you want to view.

Work Flow ID Displays the identifier of the voice work flow whose details you want to view.

Description Displays the description of the voice work flow.
Note: This is an editable field.
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The following table describes the Workflow Activity Association panel of the Voice Work Flow Details 
dialog box.

Modify a Voice Workflow
Perform the following steps to modify a voice workflow:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications.
4. The Voice Applications panel is displayed. Double-click the voice application that contains the voice 

work flow whose details you want to modify.
5. The Voice Application Details dialog box is displayed. Click the Voice Work Flow tab. 
6. The Voice Work Flow panel is displayed. Select the voice workflow whose details you want to modify, 

and click . 

7. The Voice Work Flow Details dialog box is displayed. Make the necessary changes, and click .

Delete a Voice Workflow
Perform the following steps to delete a voice workflow:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. Double-click the voice application that contains the voice 

work flow you want to delete. 
5. The Voice Application Details dialog box is displayed. Click the Voice Work Flow tab. 
6. The Voice Work Flow panel is displayed. Select the voice work flow that you want to delete, and click 

. 
7. A confirmation dialog box is displayed. Select OK confirm the deletion of the voice workflow.

Field Description

Activity Group ID Displays the identifier of the activity group that is associated with the voice work flow.

Activity Code Displays the identifier of the activity code for the corresponding activity group.
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Delete a Voice Workflow Activity Association:
Perform the following steps to delete a voice workflow activity association:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. Double-click the voice application that contains the 

workflow for which you want to delete the workflow activity association. 
5. The Voice Application Details dialog box is displayed. Click the Voice Work Flow tab. 
6. The Voice Work Flow panel is displayed. Double-click the Workflow ID for which you want to delete 

the workflow activity association.
7. The Voice Work Flow Details dialog box is displayed. From the list, select the Workflow Activity 

Association that you want to delete, and click .
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Associate a Voice Application Instance with a Ship Node
Before associating a voice application with a node, ensure that the corresponding data load services and 
voice application instances are configured correctly. Each ship node is associated to a voice application 
instance. This enables the ship node to derive all the integration parameters from the voice application 
instance.

Perform the following steps to associate a voice application instance with a ship node:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent Voice Integration, and double-click Associate Voice 
Application. 

4. The Associate Voice Application Instance window is displayed. Enter information in the applicable 

fields, and click .

The following table describes the fields in the Associate Voice Application Instance dialog box.

Note: When you create a new node from an existing node using the Copy Node functionality, the Sterling 
Warehouse Management System will not associate the Voice Application instance to the new node. 
In order to enable voice in the new node, you must manually configure voice-related configuration 
as explained in the following topics:

Configuring a Voice Application

Configuring a Voice Application Instance

Configuring a Voice Workflow

Field Description

Voice Application Select the appropriate voice application from the drop-down list.

Voice Application 
Instance

From the drop-down list, select the voice application instance that you want to associate 
with the ship node.
Note: The voice application Instance drop-down list is populated based on the voice 
application that is selected. The drop-down list displays all the voice instances 
corresponding to the selected voice application.



Associate a Task Type with a Voice Workflow
In the Sterling Warehouse Management System, task type configuration, which is carried out by the user, 
enables that user to configure voice-based task types, for example, voice picking. A user can select the Voice 
option in the Device Option screen of the Task Type wizard.

Perform the following steps to associate a task type with a voice workflow:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management.
3. The tree is expanded. Double-click Task Types. 
4. The Task Types window is displayed. Select the Activity Group within which you want to create a task 

type, for example, Outbound Picking, and click .

5. The Task Type wizard is displayed. In the Task Type field, enter a name for the task type. In the 
Description field, enter a description of the Task Type. (This description will be displayed in the Task 
Types tree.) From the Activity drop-down list, select an activity. (The items that are displayed in this 
list correspond to the activity group for which you are configuring a task type.) Click Next and 
configure all the screens by referring to the Sterling Warehouse Management System: Configuration 
Guide until you reach the screen where you can configure a device for performing the outbound 
picking task.
Note: When configuiring a task type, do not enter the value 00 for the Task Type because this value is 
treated as a dummy value.
Sterling Commerce, Inc. 36



6. In the screen that is displayed, select Voice. This configures the task type to use voice. Click Next.
Note: Voice will be displayed as an option in the Task Type wizard only when a voice application 
instance is defined for the out-of-the-box VOXWARE voice application (at the Hub level 
(DEFAULT)), and is associated to the node.

7. In the screen that is displayed, select a workflow from the Voice Workflow drop-down list, based on 
which the tasks belonging to this task type will be performed.
Note: The Voice Workflow drop-down list contains only those workflows that are associated with the 
selected activity group and activity code, for example, if you select Outbound Picking as the activity 
group, only the workflows associated with Outbound Picking will be populated in the Voice Workflow 
drop-down list.

8. Perform the corresponding actions for the other screens of the Task Type wizard, and click Finish. For 
more information about the screens, refer to the Sterling Warehouse Management System: 
Configuration Guide.
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Note: Out-of-the-box, the grammar file supports only numeric responses for task type. Grammar can be 
customized to support alphanumeric values. If you want to do so, please contact Sterling Customer Support. 
Only when a task type is configured as a voice pick task type, can it be uploaded to VLP.
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New Barcode Types for Task Execution
In order to translate check digits of different data such as Container ID, Serial Number, and Tag Attributes, 
the following barcode types have been introduced in the Sterling Warehouse Management System.

Target Container Input for Voice Picking
The Barcode Translation Sources that are provided out-of-the-box for the Target Container Input For Voice 
Picking barcode type are as follows:

✦ Target Container Check Digit Scan - This translator looks for any Container ID whose last 5 digits is 
the input barcode data.

✦ Case ID - The Case ID source validates if the scanned data is an existing Case SCM in the Sterling 
Warehouse Management System. If this case contains only a single item, the source returns item 
details such as Item ID, unit of measure, and quantity

✦ Pallet ID - The Pallet ID source validates if the scanned data is an existing Pallet SCM in the Sterling 
Warehouse Management System. If this pallet contains only a single item, the source returns item 
details like Item ID, unit of measure, and quantity.

✦ UCC 128 Code - This is a widely used barcode standard. UCC 128 Code source validates if the 
scanned data conforms to the UCC 128 standards.

✦ Generate 20-digit Container Number - This source generates a 20-digit Container ID, with the last five 
digits being the barcode data passed. This source internally invokes the generateSCM API to generate 
the first 15 digits of the Container ID.

Source Container Input for Voice Picking
The Barcode Translation Sources that are provided out-of-the-box for the Source Container Input For Voice 
Picking barcode type are as follows:

✦ Source Container Check Digit Scan - This translator looks for any Container ID whose last 5 digits is 
the input barcode data.

✦ Case ID - The Case ID source validates if the scanned data is an existing Case SCM in the Sterling 
Warehouse Management System. If this case contains only a single item, the source returns item 
details such as Item ID, unit of measure, and quantity

✦ Pallet ID - The Pallet ID source validates if the scanned data is an existing Pallet SCM in the Sterling 
Warehouse Management System. If this pallet contains only a single item, the source returns item 
details like Item ID, unit of measure, and quantity.

✦ UCC 128 Code - This is a widely used barcode standard. UCC 128 Code source validates if the 
scanned data conforms to the UCC 128 standards.

✦ Generate 20-digit Container Number - This source generates a 20-digit Container ID, with the last five 
digits being the barcode data passed. This source internally invokes the generateSCM API to generate 
the first 15 digits of the Container ID.
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Serial Input for Voice Picking
The Barcode Translation Source that is provided out-of-the-box for the Serial Input For Voice Picking 
barcode type is as follows:

Serial Number for Voice Pick - This source validates whether the scanned data is the last five digits of a 
valid serial number in the Sterling Warehouse Management System.

Item Tag Input for Voice Picking
The Barcode Translation Source that is provided out-of-the-box for the Item Tag Input For Voice Picking 
barcode type is as follows:

Item Tag for Voice Pick - This source validates whether the scanned data is the last five digits of one of the 
tag attributes of the selected item.
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Configure a Zone Check Digit
The zone codes, which are used in a warehouse to identify a particular zone, are usually long, and contain 
alphanumeric strings. Long strings such as these are not recommended in voice-based systems because the 
chances of an error occurring are high. In order to avoid such errors, a shorter version of the code, known 
as a check digit, is used. Check digits are usually 2-5 digits long, easy to read, and are used to identify a 
given zone.

Note: For more information about check digits, refer to the VLP Bookshelf Guide.

Perform the following steps to configure a location check digit:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Warehouse Layout.
3. The tree is expanded. Double-click Zones. 

4. The Zones window is displayed. Click .
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5. The Zone Details window is displayed. Enter a check digit for the zone in the Check Digit field. Enter 

information in the applicable fields, and click . For field value descriptions, refer to the Sterling 
Warehouse Management System Configuration Guide.
Note: When configuiring a zone check digit, do not enter the value 00 because it is treated as a dummy 
value.

Note: Out-of-the-box, the grammar file supports only numeric responses for location check digits. The 
grammar file can be customized to support alphanumeric values. If you want to do so, contact Sterling 
Customer Support.
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Configure a Location Check Digit
The location codes, which are used in a warehouse to identify a particular location, are usually long, and 
contain alphanumeric strings. Long strings such as these are not recommended in voice-based systems 
because the chances of an error occurring are high. In order to avoid such errors, a shorter version of the 
code, known as a check digit, is used. Check digits are usually 2-5 digits long, easy to read, and are used to 
identify a given location.

Note: For more information about check digits, refer to the VLP Bookshelf Guide. It is required to 
configure the location check-digits in order to upload the records in VLP.

Perform the following steps to configure a location check digit:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Warehouse Layout.
3. The tree is expanded. Double-click Locations. 
4. The Location Search window is displayed. In the Locations panel of the Location Search window, 

click .
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5. The Location Details window is displayed. Enter a check digit for the location in the Check Digit field. 

Enter information in the applicable fields, and click . For field value descriptions, refer to the 
Sterling Warehouse Management System Configuration Guide.
Note: Because there are multiple locations in a warehouse, the Sterling Warehouse Management 
System provides a mechanism to compute check digits for all the locations.

In order to support mass maintenance of locations in a warehouse, the Sterling Warehouse 
Management System has provided a mass maintenance mechanism to compute and maintain the 
Location Check Digits. For more information about location mass maintenance, refer to Location 
Mass Maintenance.
Note: Out-of-the-box, the grammar file supports only numeric strings or digits for Case ID, Pallet ID, 
Serial No, Tag Attributes, Zone Check Digit, Equipment Check, and Task Type ID. The grammar file 
can be customized to support alphanumeric values. If you want to do so, please contact Sterling 
Customer Support.

Location Mass Maintenance
Warehouse managers can use the Sterling Warehouse Management System to update the attributes of a set 
of locations simultaneously. Location mass maintenance supports a mass maintenance mechanism to 
compute and maintain the Location Check Digits. 

Perform the following steps to configure the check digits for computing locations:

1. Log in to the Sterling Multi-Channel Fulfillment Solution Consoles, and from the menu bar, navigate 
to Inventory > Location Mass Maintenance.
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2. The Location Mass Maintenance window is displayed, as shown here. Select the Compute Check Digit 
check box, and click Save.
Note: For other field value descriptions, refer to the Sterling Warehouse Management System 
Implementation Guide.

Location check digit computation is a customized solution, and the 
YNWComputeLocationCheckDigitUE user exit must be implemented to compute the check digits for 
the locations.
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Configure an Equipment Check Digit
The equipment codes, which are used in a warehouse to identify a particular equipment, are usually long, 
and contain alphanumeric strings. Long strings such as these are not recommended in voice-based systems 
because the chances of an error occurring are high. In order to avoid such errors, a shorter version of the 
code, known as a check digit, is used. Check digits are usually 2-5 digits long, easy to read, and are used to 
identify a given equipment.

Note: For more information about check digits, refer to the VLP Bookshelf Guide. Use the instructions 
provided in this guide to configure the equipment check digits to upload records in VLP.

Perform the following steps to configure an equipment check digit:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Warehouse Layout. 
3. The tree is expanded. Double-click Equipment.
4. The Equipment window is displayed. From the list, select the Equipment Type for which the 

equipment is to be created, and click . 
5. The Equipment dialog box is displayed. Enter a check digit for the equipment in the Check Digit field. 

Enter information in the applicable fields, and click . For field value descriptions, refer to the 
Sterling Warehouse Management System Configuration Guide.

Notes: 

When configuiring an equipment check digit, do not enter the value 00 because it is treated as a 
dummy value.
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Out-of-the-box, the grammar file supports only numeric responses for equipment check digits. The 
grammar file can be customized to support alphanumeric values. If you want to do so, contact 
Sterling Customer Support.

Equipments are unique across warehouses in VoiceLogistics Pro (VLP). Incase multiple warehouses 
are implemented for the same VLP instance, ensure that for a particular equipment, the check digit is 
the same across these warehouses.
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Configure Pick Execution Exception Reason Code Check Digit
The pick execution exception codes, which are used in a warehouse to identify a particular execution 
exception reason, are usually long, and contain alphanumeric strings. Long strings such as these are not 
recommended in voice-based systems because the chances of an error occurring are high. In order to avoid 
such errors, a shorter version of the code, known as a check digit, is used. Check digits are usually 2-5 digits 
long, easy to read, and are used to identify a given execution exception reason code.

For more information about check digits, refer to the VLP Bookshelf Guide. Use the instructions provided 
in this guide to configure the pick execution exception codes check digits to upload records in VLP.

Perform the following steps to configure a pick execution exception reason code check digit:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management System.

2. From the tree in the application rules side panel, click  or double-click Task Management. 
3. The tree is expanded. Double-click Execution Exceptions. 
4. The Execution Exception window is displayed. By default, the Pick tab is selected. If this tab is not 

selected, click the Pick tab. 

5. The Execution Exception panel for Pick tasks is displayed. Click .
6. The Execution Exception Code Details dialog box is displayed. Enter a check digit for the pick 

execution exception reason code in the Check Digit field. Enter information in the applicable fields, 

and click . For field value descriptions, see the Sterling Warehouse Management System 
Configuration Guide.

Note: Out-of-the-box, the grammar file supports only numeric responses for pick execution exception 
codes (short or skip reason) check-digits. The grammar file can be customized to support alphanumeric 
values. If you want to do so, please contact Sterling Customer Support.
The pick execution exception codes are unique across warehouses in VoiceLogistics Pro (VLP). Incase 
multiple warehouses are implemented for the same VLP instance, ensure that for a particular pick 
execution exception code, the check digit is the same across these warehouses.
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Configure the Inventory Adjustment Reason Code
Pick Confirmation Notification and Assignment Completion Notification are asynchronous events in VLP. 
When there is an inventory mismatch between the system quantity and the quantity that is physically present 
in a location, task completion in the Sterling Warehouse Management System may fail. Because task 
completion is in the offline mode, its failure is not communicated to the user during voice task execution. 
In order to avoid errors arising out of such scenarios, an option has been provided for performing negative 
adjustment of  inventory in a bin location, and a corresponding positive adjustment of inventory in the pick 
location. This adjustment is done by associating a reason code to the bin location, and associating the same 
reason code to the default OverPick for Voice-Based Tasks operation.

Perform the following steps to associate a reason code to the OverPick for Voice-Based Tasks operation:

1. Open the Applications Manager, and navigate to Applications > Application Platform.
2. The application rules side panel is displayed. Select Participant Modeling > Participant Setup.
3. The Organization Search window is displayed. Search for organizations and double-click the node 

whose details you want to view.
4. The Organization Details window is displayed. Select the Roles and Participation tab. Select the 

Advanced Attributes tab. In the Inventory Adjustment Reasons panel, select a value from the OverPick 

For Voice Based Tasks drop-down list, and click .

Note: This feature will not work for serial-tracked inventory.



Manual Data Loading
Manual data loading, or initial one-time data loading is, as its name suggests, a one-time process that loads 
all the necessary configuration data. This task must be performed for each node separately.

Note: Prior to loading data, ensure that all the services are configured as mentioned in the topic Configure 
Data Upload and Import Services.

Perform the following steps to carry out one-time data loading:

1. Run the integration server or servers associated with the Sterling Warehouse Management System data 
upload services.

2. Set the values for the following environment variables as specified in this list:

YFS_RT must point to the installation directory of the Sterling Warehouse Management System.

ANT_HOME must point to the ANT installation directory.

JAVA_HOME must point to the Java installation directory.

3. Run the following ant script from the <INSTALL_DIR>/bin directory:
ant -f ynw_entity_uploader.xml -Dnode=Node

Here, Node refers to the ship node.
Notes: 

For each entity that is uploaded, the entity uploader utility creates a restart file. The restart file has 
the key of the last entity record processed. This key is used for subsequent data uploads when the 
records that are already uploaded have to be ignored. The restart files are created in the 
<INSTALL_DIR>/bin folder.

Install the following third party jars for the Websphere application server:

- j2ee.jar
- com.ibm.ws.sib.client.thin.jms_7.0.0.jar
- com.ibm.ws.ejb.thinclient_7.0.0.jar
- com.ibm.ws.orb_7.0.0.jar
- com.ibm.ws.wccm.jar

After the installation is complete, the AGENTDynamicclasspath.cfg file will be updated.
4. Run the readSterlingDataLoadFiles.bat file from the <Voxware Install 

Folder>/vlp_core/voxconnect_build/bin/ directory. This file invokes the following VLP 
Data Import events:

VLP_WAREHOUSE_LOAD

VLP_ZONE_LOAD

VLP_LOCATION_LOAD

VLP_EQUIPMENT_LOAD

VLP_REASON_LOAD
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VLP_WORKTYPE_LOAD

VLP_PRODUCT_LOAD

Notes: 

Sterling Warehouse Management System provides only one batch file for all the events. However, 
it is recommended that the user create separate batch files for individual events.

The user must manually verify the log files to keep track of data load failures, if any.
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Automatic Data Loading
After initial one-time data loading is performed for the configuration data, if changes are made to the 
Sterling Warehouse Management System configuration later, VoiceLogistics Pro (VLP) must import these 
changes to facilitate data synchronization. Data loading is thus an automatic and continuous process.

Note: Prior to loading data, ensure that all the services are configured as mentioned in the topic Configure 
Data Upload and Import Services.

Perform the following steps to carry out continuous data loading:

1. Ensure that the integration server or servers associated with the Sterling Warehouse Management 
System data upload services are always running.

2. Ensure that the readSterlingDataLoadFiles.bat file that is located under the <Voxware 
Install Folder>/vlp_core/voxconnect_build/bin/ directory is invoked by a scheduler 
regularly. This scheduler is, however, not provided out-of-the-box. This batch file invokes the 
following VLP Data Import events:

VLP_WAREHOUSE_LOAD

VLP_ZONE_LOAD

VLP_LOCATION_LOAD

VLP_EQUIPMENT_LOAD

VLP_REASON_LOAD

VLP_WORKTYPE_LOAD

VLP_PRODUCT_LOAD

Notes: 

Sterling Warehouse Management System provides only one batch file for all the events. However, 
it is recommended that the user create separate batch files for individual events. For more 
information about how to run data import events, refer to the VLP Bookshelf Guide.

The user must manually verify the log files to keep track of data load failures, if any.



Manage VoiceLogistics Pro Users
All the users of VoxStudio, VoxConnect, and VoxConsole, which are a part of the VoiceLogistics Pro suit 
of tools, must, along with the workers in a warehouse, be defined as VLP users. Users can be associated 
with applications, customers, shifts, work types, and work places.

A user must be assigned a role in order to determine the level of access to the application. By default, VLP 
provides the following user roles - Administrator, Supervisor, and User. You can create a user, search for a 
user, edit information pertaining to a user, and assign a user to an application workflow. Every workflow 
has its own set of grammar definitions. Therefore, a new user assigned to a workflow must be trained in 
grammar definition.

A worker must be added and configured as a user in the VoxConsole before being able to perform voice 
training, which allows VoxConsole to adapt to a user's voice and speech pattern.

Voice personalization adapts a user's speech pattern by carrying out voice training with sample phrases 
which that user uses when performing a task. Users speak naturally as they would to another person without 
significant pauses between words. During voice training, users speak at a conversational volume level and 
speed.

There are certain requisites for voice training, which can be performed in the following ways:

✦ Control Training
✦ Personalization
✦ Advanced Personalization
Note: All warehouse users must be manually created in VLP. Ensure that the User ID created in VLP is 

same as the Login ID for the user in the Sterling Warehouse Management System. For more 
information about user management and voice training, refer to the VLP Bookshelf Guide.
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After a user is created in VoxConsole, the following configuration must be carried out for individual users 
for successful implementation of the Picking application at runtime:

1. Assign the user to the Picking application, as shown in the following figure. For more information 
about assigning a user to Picking application, refer to the VLP Bookshelf Guide.

Notes: 

If you remove an application from the Selected Applications list, all the voice files created by the 
user for this application are deleted. 

The user must redo the voice training again if the same application is selected again.
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2. Assign the user to the 24-hour shift, as shown in the following figure. For more information about 
assigning a user to 24-hours shift, refer to the VLP Bookshelf Guide.

3. Assign the user to Work Types, as shown in the following figure. It is recommended that you associate 
all the available Sterling Warehouse Management System work types to the user. The Warehouse 
Management System APIs will take care of the user task types. For more information about assigning 
a user to work types, refer to the VLP Bookshelf Guide.
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4. Assign the user to Work Places, as shown in the following figure. It is recommended that you associate 
all the available zones of the warehouse to the user. For more information about assigning a user to 
work places, refer to the VLP Bookshelf Guide.
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Supported Voice Pick Use Cases
The Sterling Warehouse Management System has provided an out-of-the-box PICKING workflow to 
support order picking in a warehouse. This out-of-the-box workflow does not, however, support other 
warehouse execution processes, such as retrieval, replenishment, putaway, batch pick, item pick, and more. 
The PICKING workflow supports the use cases described in the subsequent tables in this section. The use 
cases are classified based on the following governing factors:

✦ Task Type
✦ Item Attributes
✦ Inventory
✦ Exception
The following table lists the use cases that are governed by task type.

Use Case Supported Description

Activity Yes Only order pick (outbound picking) is 
supported.

Pick into Equipment Yes Inventory can be picked into an 
equipment.

Pick into Case Yes Inventory can be picked into a case. 
It can either be a new case, or an 
existing one.
Note: A case is identified by the last 
five digits. For a new case, an 
out-of-the-box 
YNWTargetContainerForVoicePick 
barcode type converts those 5 digits 
into a valid Case ID.

Pick into Pallet Yes Inventory can be picked into a pallet. 
It can either be a new pallet, or an 
existing one.
Note: A pallet is identified by the last 
five digits. For a new pallet, an 
out-of-the-box 
YNWTargetContainerForVoicePick 
barcode type converts those 5 digits 
into a valid Pallet ID.

Apply License Plate while Picking No A user can not apply reprinted 
license plates when picking.

Allow Over Picking Yes A user can pick more than the 
suggested task quantity. 
Note: Over Picking is not allowed for 
serial-tracked inventory.
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The following table lists the use cases that are governed by item attributes.

Pack while Pick No A user cannot perform packing 
activity while picking.

System Driven Yes The system will suggest one task at a 
time. 
However, the user is given the option 
to filter the tasks by Task Type and 
Zone criteria.

User Driven No The system will not allow the user to 
select a task from a set of tasks. 
However, tasks can be filtered by 
Task Type and Zone criteria.

Multi-Step Execution No After the task is completed at the 
staging location, the Sterling 
Warehouse Management System 
creates a subsequent putaway task 
type. The PICKING workflow does 
not support execution of the putaway 
tasks. 
In order to execute the putaway task, 
a different workflow that supports 
putaway task execution is required. 
Putaway workflow is not provided 
out-of-the-box by the Sterling 
Warehouse Management System.

Use Case Supported Description

Serial Capture Yes Serial is identified by the last five 
digits. It is assumed that no location 
will have two serials with the same 
last five digits. 
Note: A task with a requested serial 
will not be suggested for voice pick. 
In such a scenario, the status of the 
task will change to HELD with a 
default reason text specified against 
it.

Tag Capture Yes Item Tag identifiers are captured for 
tag-tracked items.
Note: A task with a requested tag will 
not be suggested for voice pick. In 
such a scenario, the status of the 
task will change to HELD with a 
default reason text specified against 
it.

Use Case Supported Description
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The following table lists the use cases that are governed by inventory.

The following table lists the use cases that are governed by exception.

Time-Sensitive Items Yes/No The ShipByDate and ExpiryDate are 
not captured for time-sensitive items. 
The status of the task will change to 
HELD with a default reason text 
specified against it.
However, if a location has only a 
unique ship-by-date inventory, or if 
the item is serial-tracked, the 
time-sensitive items can be picked 
up using this workflow.

FIFO Yes Voice-based tasks to be allocated in 
the order of first in first out (FIFO).

Use Case Supported Description

Picking Loose Inventory from 
Location

Yes A user can pick loose inventory from 
a location.

Picking Inventory from Break Case Yes A user can pick partial inventory from 
a case.

Picking Inventory from Full Case Yes A user can pick a full case.

Picking Inventory from Break Pallet Yes A user can pick partial inventory from 
a pallet.

Picking Inventory from Full Pallet Yes A user can pick a full pallet.

Picking Vendor Managed Inventory No To perform voice-based picking 
tasks, the Sterling Warehouse 
Management System considers 
inventory that is owned by an 
enterprise. Inventory owned by 
consumable organizations for the 
enterprise is not considered for 
voice-based picking tasks.

Use Case Supported Description

Skip Task Yes A user can skip the suggested task 
by passing the SKIP exception code.

Hold Task Yes A user can put a task on hold for a 
certain quantity.

Suggest Alternate Pick Location Yes A user can request for an alternative 
pick location.

Use Case Supported Description
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Notes:

✦ The out-of-the-box DemoPicking.grm file provided by the Sterling Warehouse Management System 
supports only the numeric string in the last five digits of the following attributes:

Serial Number

Case ID

Pallet ID

Tag ID

If any of the last five digits of these attributes is a alphanumeric string, the grammar file should be 
modified by the user accordingly.

✦ All the voice pick tasks that are not suggested during voice picking, for example, Suggest Alternate 
Pick Location, Multi-Step Execution, and so on, can be completed using the Sterling Warehouse 
Management System Console.

✦ Voice picking cannot be performed using a radio frequency device.

Freeze On Variance Yes A user can mark the original source 
location for picking as Frozen.

Mark Target Location As Full No Deposit exceptions are not supported 
because this is not supported by 
Voxware.

Freeze For Putaway No Deposit exceptions are not supported 
because this is not supported by 
Voxware.

Suggest Alternate Deposit Location No Deposit exceptions are not supported 
because this is not supported by 
Voxware.

Deposit into Pallet No Target Location Override is not 
supported.

Allow Partial Deposit No Deposit exceptions are not supported 
bacause this is not supported by 
Voxware.

Use Case Supported Description
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VoxBlocks Used in the Picking Workflow
VoxBlocks are the fundamental building blocks of a workflow, and represents a process or a function. It is 
essential to understand what each VoxBlock does, the voice prompts pertaining to each VoxBlock, the 
events that must be activated to help the process of transferring data from VoiceLogistics Pro (VLP) to the 
Sterling Warehouse Management System, and vice versa, and the user exits that should be called to extend 
the standard VLP product functionality.

Based on the order in which the VoxBlocks are arranged in the PICKING workflow, this topic explains one 
VoxBlock at a time, the prompts that are used for that VoxBlock, and the properties of that VoxBlock.

Perform the following steps to view the VoxBlocks pertaining to the PICKING workflow:

1. Open VoxStudio using the default user name SUPERVISOR and default password voxware. 
The VoxStudio user interface is displayed.

2. From the VoxStudio menu bar, navigate to File > Open Workflow Group.
3. The Create dialog box is displayed. Browse to 

<voxhome>/SterlingPickingWorkflow\workflow\STERLING_VOICE_WORKFLOWS, select 
STERLING_VOICE_WORKFLOWS.wsf from the list, and click Open. 

The PICKING workflow is displayed in the VoxStudio workspace, as shown in the following figure.
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Note: In a workflow, you can use two types of prompts, one provided by Sterling Commerce, and the other 
provided by Voxware. The PICKING workflow uses prompts provided by the Sterling Warehouse 
Management System.

Log On
The Log On functionality verifies the identity of the worker, and allows the user to log in to the system.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Log On VoxBlock properties that 
are activated for the PICKING workflow.

When you click Log On VoxBlock, the Log On - VoxBlock Properties panel is displayed on the left side of 
the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for Log On VoxBlock 
None

✦ Enabled Properties for Log On VoxBlock 
None

✦ Enabled User Exits for Log On VoxBlock 
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After Log On

Implementation Details:
This user exit derives the node information from the corresponding user profile. For code details, 
go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\afterlogonexit

Equipment Verification
The Equipment Verification functionality verifies the identifier of the equipment based on the equipment 
check digit configuration. In the Picking workflow, equipment verification is mandatory, However, if you 
do not want to use an equipment for performing the task, the Sterling Warehouse Management System 
provides a dummy equipment ID value of 00, which can be entered during equipment verification.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This subsection discusses the properties of an Equipment 
Verification VoxBlock that are activated for the PICKING workflow.

After you click the Equipment Verification VoxBlock, the Equipment Verification - VoxBlock Properties 
panel is displayed on the left side of the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following parts depending on the functionality:
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✦ Enabled Events for Equipment Verification VoxBlock 
None

✦ Enabled Properties for Equipment Verification VoxBlock
None

✦ Enabled User Exits for Equipment Verification VoxBlock
After Equipment Verification

Implementation Details:
This user exit derives the Equipment ID from the check digit. The Filler field is used for storing 
the Equipment ID. For code details, go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\afterequipmentverificationexit

Zone Verification
The Zone Verification functionality manages the process of verifying valid zone assignments to users, and 
verifies whether a user is allowed to work in a particular zone or not. In the Picking workflow, zone 
verification is mandatory. However, if you do not want to specify the zone from which to begin a task, the 
Sterling Warehouse Management System provides a dummy zone value of 00, which can be entered during 
zone verification.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Zone Verification VoxBlock 
properties that are activated for the PICKING workflow.
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When you click Zone Verification VoxBlock, the Zone Verification - VoxBlock Properties panel is 
displayed on the left side of the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following parts based on the functionality: 

✦ Enabled Events for Zone Verification VoxBlock
None

✦ Enabled Properties for Zone Verification VoxBlock
None

✦ Enabled User Exits for Zone Verification VoxBlock
After Zone Verification

Implementation Details:
This derives the Zone ID from the zone check digit. Zone Description is used for storing the Zone 
ID. For code details, go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\afterzoneverificationexit 

Work Type Verification
The WorkType Verification functionality verifies whether a user is allowed to work on a specific work type 
or not. In the Picking workflow, work type verification is mandatory, However, if you do not want to filter 
the task using work type, the Sterling Warehouse Management System provides a dummy work type value 
of 00, which can be entered during work type verification.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.
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Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the WorkType Verification VoxBlock 
properties that are activated for the PICKING workflow.

When you click WorkType Verification VoxBlock, the WorkType Verification - VoxBlock Properties 
panel is displayed on the left side of the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for WorkType VoxBlock
None

✦ Enabled Properties for WorkType VoxBlock
None

✦ Enabled User Exits for WorkType VoxBlock
After Work Type Verification

Implementation Details:
This is implemented to invoke the markTaskAvailability API of the Sterling Warehouse 
Management System in order to mark the availability of tasks for the user. For code details, go to 
the following folder:
<Vox_Install>\vlp_core\src\voxexits\afterworktypeverificationexit
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Assignment
The Assignment functionality defines how work is assigned to users.

Voice Prompts

✦ Prompts provided by Sterling Commerce: 
None

✦ Prompts provided by Voxware: 
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Assignment VoxBlock properties 
that are activated for the PICKING workflow.
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When you click Assignment VoxBlock, the Assignment - VoxBlock Properties panel is displayed on the 
left side of the VoxStudio user interface, as shown in the following figure.
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This panel is divided into the following parts based on the functionality: 

✦ Enabled Events for Assignment VoxBlock
Assignment Request

This is an outbound synchronous event that waits for response from the Sterling Warehouse 
Management System in the form of assignments. The following figure shows the 
SterlingWMS_AssignmentRequest_85 transport associated to the Assignment Request event. The 
YNW_AssignmentRequest_85 service assigns the first available task to the user based on the input 
criteria.

The following figure shows the registration of the Assignment Request event with the 
Sterling_VLPAssignmentRequest_85 transport.
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Single Task Request

This is an outbound synchronous event that waits for response from the Sterling Warehouse 
Management System in the form of a single task. The following figure shows the 
SterlingWMS_PickRequest_85 transport associated to the Single Task Request event. 
The YNW_PickRequest_85 service returns a task depending on the previous task. The behavior is 
as follows:
- If the previous task is skipped, it returns the task for the next available location in sequence.
- If the previous task was cut, the Sterling Warehouse Management System will not suggest any 
more tasks. A cut made in VLP is mapped as a deposit request in the Sterling Warehouse 
Management System.
- If none of these behaviors hold true, the service assigns the next available task to the user.

The following figure shows the registration of the Single Task Request event with the 
SterlingWMS_PickRequest_85 transport.
Sterling Commerce, Inc. 70



Assignment Completion Notification

This is an outbound asynchronous event that notifies Sterling Warehouse Management System that 
the assigned task is complete. The following figure shows the 
SterlingWMS_AssignmentCompletion_85 transport associated to the Assignment Completion 
Notification event. An assignment consists of multiple tasks. The 
YNW_AssignmentCompletion_85 service puts the task completion message for the following:
- Tasks against which at least one unit was picked.
- Tasks against which pick exception is logged.
- Tasks against which ship exception is logged.

The following figure shows the registration of the Assignment Completion Notification event with 
the SterlingWMS_AssignmentCompletion_85 transport.

This event puts a message for the asynchronous agent. Thus, this agent should be running in order 
to complete the corresponding task in the Sterling Warehouse Management System. The 
assignment completion message for the asynchronous agent will be lost if the Sterling Warehouse 
Management System server is down as VLP does not have a backup or restart capability for event 
messages.
Note: It may take some time for the message to be picked up by the asynchronous agent. In order 
to avoid conflict with the Reopen Task agent, the voice-based tasks that are in the SUGGESTED 
status will not be reopened.

✦ Enabled Properties for Assignment VoxBlock: 
Require “Ready To Go”

This is a confirmation step to proceed with the assignment. This property has the following 
defined voice prompts (VP) and voice inputs (VI):
VI: Say "Ready To Go"
VP: "Ready To Go"
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✦ Enabled User Exits for Assignment VoxBlock: 
Before Assignment

Implementation Details:
Voxware uses the UserContainer session object to keep track of the entire course of task execution. 
In case of systematic failures such as unit battery shut down or server connection failures, the user 
container is used to recover data from the last point of failure.
In the PICKING workflow, UserContainer keeps track of all the inventory attributes that were 
captured during task execution in order to enable safe recovery for custom implementation. The 
Before Assignment user exit has been implemented to clear the attributes of previous assignments 
contained in the user container. This user exit also marks the task availability for the user as Y.
For code details, go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\beforeassignmentexit

Container Setup
The Container Setup functionality provides the Pick into Container functionality to pick inventory into a 
target container. If an assignment requires container setup, the system prompts the user to add containers to 
perform the pick task. The user is allowed to add as many containers required to perform the assignment. 
However, in order to be able to pick a new container, the user should first drop the previous container.

Voice Prompts

✦ Prompts provided by Sterling Commerce: 
None

✦ Prompts provided by Voxware: 
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Container Setup VoxBlock 
properties that are activated for the PICKING workflow.
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When you click Container Setup VoxBlock, the Container Setup - VoxBlock Properties panel is displayed 
on the left side of the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for Container Setup VoxBlock
Container Type Request

This is an outbound synchronous event that waits for response from the Sterling Warehouse 
Management System in the form of container type to be used for picking. The following figure 
shows the SterlingWMS_ContainerTypeRequest_85 transport associated to the Container Request 
event. The YNW_ContainerTypeRequest_85 service returns the container type (pallet or case) to 
be used for picking, based on the task type configuration.

The following figure shows the registration of the Container Request event with the 
SterlingWMS_ContainerTypeRequest_85 transport.
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Container ID Verification Request

This is an outbound synchronous event that waits for response from the Sterling Warehouse 
Management System in the form of VLP Confirmation XML, with an Error Code attribute. The 
value of the Error Code attribute is 0 if it is a valid container in the Sterling Warehouse 
Management System, otherwise, the value is 2. The following figure shows the 
SterlingWMS_ContainerIdValidate_85 transport associated to the Container Type Request event.

The following figure shows the registration of the Container ID Verification Request event with 
the SterlingWMS_ContainerIdValidate_85 transport. 

✦ Enabled Properties for Container Setup VoxBlock
None

✦ Enabled User Exits for Container Setup VoxBlock
None

Location
The Location functionality prompts users with location information and provides mechanisms to verify 
locations and items.

Voice Prompt

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Location VoxBlock properties that 
are activated for the PICKING workflow.
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When you click Location VoxBlock, the Location - VoxBlock Properties panel is displayed on the left side 
of the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following two parts based on the functionality:

✦ Enabled Properties for Location VoxBlock 
Allow Cut Item

During a location prompt, users can cut the task by saying “Cut this Item”. After the cut, the 
Sterling Warehouse Management System will not suggest any further task, and the user will be 
prompted with the confirm completion prompt.

Allow Skip Location

During a location prompt, users can skip the location by saying "Skip this Location".

Require Reason for Skips

To skip a location, users must enter a reason.
✦ Enabled User Exits for Location VoxBlock 

Before Location

Implementation Details
In the Location VoxBlock, the Pick_Request event is enabled. Every time the Pick_Request event 
is invoked, a task is requested from the Sterling Warehouse Management System. The Before 
Location user exit has been implemented to incorporate logic in order to allow the user to decide 
whether to get the next task from the Sterling Warehouse Management System or not. For code 
details, go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\beforelocationexit
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Pick 
The Pick functionality manages the process of assigning work, and validating worker responses.

Voice Prompts 

✦ Prompts provided by Sterling Commerce: 
Before Pick Exit

VP: Pick <Item Description>
VI: "Got It"
VP: Verify Inventory
VI: "Pallet/Case <last 5 digits> confirm" or "loose confirm" or “ready to cut”
VP: Invalid Case/Pallet <last 5 digits> (Only if validation fails)
VI: "Yes Confirm" or "No Confirm"

After Pick Exit

VP: Say Serial <n> (Only if serial inventory exists in location)
VI: "Serial <last 5 digits> confirm"

VP: Invalid Serial <last 5 digits> (If serial is not found)
VP: Already Pick Serial <last 5 digits> (If serial is already picked)
VP: Say Serial <n+1> (for next quantity)
VP: Say <tag attribute> (only if non-serial tracked tag inventory exists in location)
VI: “Tag <last 5 digits> confirm”

✦ Prompts provided by Voxware: 
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Pick VoxBlock properties that are 
activated for the PICKING workflow.
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When you click Pick VoxBlock, the Pick - VoxBlock Properties panel is displayed on the left side of the 
VoxStudio user interface, as shown in the following figure.

This panel is divided into the following three parts based on the functionality:

✦ Enabled Events for Pick VoxBlock
Pick Exception Notification

This is an outbound asynchronous event that notifies the Sterling Warehouse Management System 
of any exceptions encountered during the picking process. The following figure shows the 
SterlingWMS_PickException_85 transport associated to the Pick Exception Notification event. 
The YNW_PickException_85 service invokes the rejectTask API for pick tasks with zero 
short-pick quantity. The pick exception message for the rejectTask API will be lost if the Sterling 
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Warehouse Management System server is down as VoiceLogistics Pro (VLP) does not have a 
backup or restart capability for event messages.

The following figure shows the registration of the Pick Exception Notification event with the 
SterlingWMS_PickException_85 transport.

✦ Enabled Properties for Pick VoxBlock
Allow Incremental Picks

This enables the incremental picking functionality in the workflow.

Allow Short Items

This enables the short picking functionality in the workflow. 
Note: When a task is short picked where the user picks lesser quantity than the system suggested 
quantity, the task for the remaining quantity will be created in the Sterling Warehouse 
Management System once the assignment completion or suspension notification is sent to the 
Sterling Warehouse Management System.

Require Reason for Short Items

This mandates entering a reason code for short picking.
✦ Enabled User Exits for Pick VoxBlock 

Before Pick

Implementation Details:
This prompts task-related information, for example, item description, and task quantity. This also 
prompts about performing case, pallet, or lose picking. For code details, go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\beforepickexit
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After Pick

Implementation Details:
This verifies the serial numbers, tag identifiers, and full LPN detection. For code details, go to the 
following folder:
<Vox_Install>\vlp_core\src\voxexits\afterpickexit

Put
The Put operation manages the process of putting picked items into a container.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Put VoxBlock properties of a that 
are activated for the PICKING workflow.

When you click Put VoxBlock, the Put - VoxBlock Properties panel is displayed on the left side of the 
VoxStudio user interface, as shown in the following figure.

This panel contains the following parts based on the functionality

✦ Enabled User Exits for Put VoxBlock
After Put

Implementation Details:
It associates the target container with the pick task. For code details, go to the following folder:
<Vox_Install>\vlp_core\src\voxexits\afterputexit
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Condition
Condition blocks represent a single step in a workflow in which branching occurs. After you drag a 
condition block from the palette to the workspace, you can connect the condition block to multiple 
VoxBlocks, and assign a condition to each connection. 

When a condition block is encountered during workflow execution, the system evaluates the condition. 
Each connection between a condition block and a VoxBlock specifies a conditional result. 

When the specified condition is met, the workflow operation proceeds to the connected VoxBlock. The 
default condition directs the workflow to the next VoxBlock in the workflow, when none of the other 
conditions are met.

Voice Prompts

✦ Prompts provided by Sterling Commerce 
None

✦ Prompts provided by Voxware 
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Condition VoxBlock properties 
that are activated for the PICKING workflow, as shown in the following figure.

When you make a connection between the Conditional VoxBlock and another VoxBlock, the following 
conditions are displayed:

✦ Enabled Conditions
More Items In Task

This enables incremental picking.

More Tasks In Assignment

This enables multiple tasks in assignment.
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Container Finalization
The Container Finalization functionality manages the process of closing and dropping off a container at a 
staging location. When the Container Setup VoxBlock is included in the workflow, the container 
finalization operation occurs after the container setup operation.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

Each VoxBlock contains a number of properties. However, activate the properties selectively depending on 
the type of workflow that you are configuring. This section discusses the Container Finalization VoxBlock 
properties of a that are activated for the PICKING workflow.

When you click Container Finalization VoxBlock, the Container Finalization - VoxBlock Properties panel 
is displayed on the left side of the VoxStudio user interface, as shown in the following figure.

This panel is divided into the following sections based on the functionality:

✦ Enabled Properties for Container Finalization VoxBlock
Verify Drop Off Location

This mandates verifying the drop off location.
✦ Enabled User Exits for Container Finalization VoxBlock

None
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Special Menu Options Used in the Picking Workflow
Special menu options are VoxBlocks that manage the processes that are activated with voice input from the 
Special Menu. They are invoked on demand, and contain assisting phrases that handle changes and 
unpredictable work conditions. The PICKING workflow has the special menu options, displayed in the 
following figure, enabled.

The Log Off special menu option is selected by default for all workflows. After you select a special menu 
option for a workflow, the corresponding tab is displayed. This tab contains the events, properties, and user 
exits of the selected special menu option.

The PICKING workflow uses the prompts provided by the Sterling Warehouse Management System. In a 
workflow, you can use two types of prompts, one provided by Sterling Commerce, and the other provided 
by Voxware.

The Special Menu Options that are enabled for the PICKING workflow are discussed in the subsequent 
sections.
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Log Off
This special menu option is selected by default. It manages the process of logging out a user from 
VoiceLogistics Pro.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties 

There are a number of properties pertaining to the Log Off tab. However, activate the properties selectively 
depending on the type of workflow that you are configuring. This section discusses the properties of a Log 
Off tab that are activated for the PICKING workflow.

When you click the Log Off tab, the panel containing the properties is displayed, as shown in the following 
figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for the Log Off
None

✦ Enabled Properties for the Log Off
None

✦ Enabled User Exits for the Log Off
None
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Go To Break
This special menu option allows the user to take a break between tasks. The user status changes from 
LOGIN to BREAK.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

There are a number of properties pertaining to the Go To Break tab. However, activate the properties 
selectively depending on the type of workflow that you are configuring. This section discusses the 
properties of the Go To Break tab that are activated for the PICKING workflow.

When you click the Go To Break tab, the panel containing the properties is displayed, as shown in the 
following figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for the Go To Break special menu option
None

✦ Enabled Properties for the Go To Break special menu option
None

✦ Enabled User Exits for the Go To Break special menu option
None
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Go To Lunch
Enabling this special menu option allows a user to take a lunch break in the middle of an execution. The 
user status changes from LOGIN to LUNCH.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

There are a number of properties pertaining to the Go To Lunch tab. However, activate the properties 
selectively depending on the type of workflow that you are configuring. This section discusses the 
properties of the Go To Lunch tab that are activated for the PICKING workflow.

When you click the Go To Lunch tab, the panel containing the properties is displayed, as shown in the 
following figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for the Go To Lunch special menu option
None

✦ Enabled Properties for the Go To Lunch special menu option
None

✦ Enabled User Exits for the Go To Lunch special menu option
None
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Suspend Assignment
This special menu option manages the process of suspending a work assignment after it is assigned to a 
worker, but is not yet completed. Assignment status changes from INPROGRESS to SUSPEND. The 
suspended assignments must be completed using VoxConsole. 

In order to notify assignment completion to the Sterling Warehouse Management System, the following 
configuration must be performed in VoxConsole:

1. Open VoxConsole using the default user name SUPERVISOR and default password voxware.

2. The VoxConsole user interface is displayed. In the Configuration panel, click  adjacent Preference.
3. The Configuration > VoxConsole Preference > Edit window is displayed. Enter ASSIGNMENT as the 

value for the Trigger to sent Complete assignments to WMS (valid input: ASSIGNMENT, TRUCK) 
variable, and click OK.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.
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Enabled Properties

There are a number of properties pertaining to the Suspend Assignment tab. However, activate the 
properties selectively depending on the type of workflow that you are configuring. This section discusses 
the properties of a Suspend Assignment tab that are activated for the PICKING workflow.

When you click the Suspend Assignment tab, the panel containing the properties is displayed, as shown in 
the following figure.

This panel is divided into the following parts based on the functionality:

✦ Enabled Events for the Suspend Assignment special menu option
Suspend Assignment Notification

This is an outbound asynchronous event that notifies the Sterling Warehouse Management System 
when an assignment is suspended. This service is the same as the 
YNW_AssignmentCompletion_85 service.

The following figure shows the registration of the Suspend Assignment Notification event with the 
SterlingWMS_SuspendAssignment_85 transport.
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✦ Enabled Properties for the Suspend Assignment special menu option
Verify Drop Off Location

This property mandates that the drop off location be verified when a user suspends an assignment. 
The prompt for this property is based on whether or not a container is used for picking the 
inventory. 
If you have picked the inventory into a container, for example, container 8 8 8 8, then the system 
will prompt the following:
VP: "Drop 8 8 8 8 8 at DOOR2"
VI: Check 12 confirm
If you have directly picked the inventory into an equipment, it will have the following voice 
prompts:
VP: "Drop off at DOOR2"
VI: Check 12 confirm

✦ Enabled User Exits for the Suspend Assignment special menu option
None

Change Zone
This special menu option allows a user to change the current source zone the user is in.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties 

There are a number of properties pertaining to the Change Zone tab. However, activate the properties 
selectively depending on the type of workflow that you are configuring. This section discusses the 
properties of a Change Zone tab that are activated for the PICKING workflow.
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When you click the Change Zone tab, the panel containing the properties is displayed, as shown in the 
following figure.

Enabled User Exits for the Change Zone special menu option:

None

Add New Container
This special menu option manages the process of allowing a user to add a container to the equipment the 
worker is using for the work assignment.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

There are a number of properties pertaining to the Add New Container tab. However, activate the properties 
selectively depending on the type of workflow that you are configuring. This section discusses the 
properties of a Add New Container tab that are activated for the PICKING workflow.
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When you click the Add New Container tab, the panel containing user exits is displayed, as shown in the 
following figure.

Enabled User Exits for the Add New Container special menu option:

None

Change Equipment
This special menu option manages the process of changing the current equipment the user is using.

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties

There are a number of properties pertaining to the Change Equipment tab. However, activate the properties 
selectively depending on the type of workflow that you are configuring. This section discusses the 
properties of a Change Equipment tab that are activated for the PICKING workflow.

When you click the Change Equipment tab, the panel containing the user exits is displayed, as shown in the 
following figure.

Enabled User Exits for the Change Equipment special menu option
Sterling Commerce, Inc. 90



None

Change Work Type
This special menu option allows the user to change the current work type. 

Voice Prompts

✦ Prompts provided by Sterling Commerce
None

✦ Prompts provided by Voxware
Refer to the VLP Bookshelf Guide.

Enabled Properties 

There are a number of properties pertaining to the Change Work Type tab. However, activate the properties 
selectively depending on the type of workflow that you are configuring. This section discusses the 
properties of a Change Work Type tab that are activated for the PICKING workflow.

When you click the Change Work Type tab, the panel containing the properties is displayed, as shown in 
the following figure.

✦ Enables Properties for the Change Work Type special menu option:
None

✦ Enabled User Exits for the Change Work Type special menu option:
None
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Data Load Services
In order to execute workflows, VoiceLogistics Pro (VLP) requires details about the Sterling Warehouse 
Management System configuration, for example, information about the warehouse, locations, zones, 
warehouse users, and the equipments being used. This topic explains attribute mapping of each 
configuration entity.

Note: The basic structure of these services and the required configuration setup are explained in the topic 
Configure Data Upload and Import Services.

This section explains the data load services that are exposed on the Sterling Warehouse Management 
System side, and the associated VLP import events, along with attribute mapping.

Ship Node Data Load Service
The transfer of data pertaining to ship nodes from Sterling Warehouse Management System to VLP is 
accomplished by two services - one on the Sterling Warehouse Management System side, and the other on 
VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box 
YNW_ShipNodeDataExporter_85 service to upload data pertaining to a ship node into a shared folder, as 
shown in the following image. 

VLP Event

VLP provides an out-of-the-box VLP_WAREHOUSE_LOAD event to import data pertaining to the ship 
node. This inbound asynchronous event is also referred to as Import Warehouse. This event is used to read 
the XML files uploaded to the common folder by the YNW_ShipNodeDataExporter_85 service.

As part of the integration, the VLP_WAREHOUSE_LOAD event is associated to the 
SterlingWMS_VLPWarehouseLoad transport on VLP side. This transport is of the Sterling Local XML 
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Reader transport type. The following figure shows the SterlingWMS_VLPWarehouseLoad transport 
associated to the VLP_WAREHOUSE_LOAD event.

The following figure shows the registration of the VLP_WAREHOUSE_LOAD event with the 
SterlingWMS_VLPWarehouseLoad transport.

The following table shows attribute mapping for ship node data between the Sterling Warehouse 
Management System and VLP.

Sterling Warehouse 
Management System Data

VLP Data

ShipNode Warehouseid

ShipNode Warehousename

ShipNodeAddressKey Address1

OwnerKey Parentwarehouseid

Localecode Filler1
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Zone Data Load Service
The transfer of data pertaining to zones from Sterling Warehouse Management System to VLP is 
accomplished by two services - one on the Sterling Warehouse Management System side, and the other on 
VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box YNW_ZoneDataExporter_85 
service to upload data pertaining to zones into a shared folder, as shown in the following image.

VLP Event

VLP provides an out-of-the-box VLP_ZONE_LOAD event to import data pertaining to zones from the 
common file. This inbound asynchronous event is also referred to as Import Zone. This event is used to read 
the XML files uploaded to the common folder by the YNW_ ZoneDataExporter_85 service.

As part of the integration, the VLP_ZONE_LOAD event is associated to the SterlingWMS_VLPZoneLoad 
transport on the VLP side. This transport is of the Sterling Local XML Reader transport type. The following 
figure shows the SterlingWMS_VLPZoneLoad transport associated to the VLP_ZONE_LOAD event.
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The following figure shows the registration of the VLP_ZONE_LOAD event with the 
SterlingWMS_VLPZoneLoad transport.

The following table represents attribute mapping for zone data between the Sterling Warehouse 
Management System and VLP.

Location Data Load Service
The transfer of data pertaining to locations from Sterling Warehouse Management System to VLP is 
accomplished by two services - one on the Sterling Warehouse Management System side, and the other on 
VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box YNW_LocationDataExporter_85 
service to upload data pertaining to locations into a shared folder, as shown in the following image.

VLP Event

VLP provides an out-of-the-box VLP_LOCATION_LOAD event to import data pertaining to locations 
from the common file. This inbound asynchronous event is also referred to as Import Location. This event 
is used to read the XML files uploaded to the common folder by the YNW_ LocationDataExporter_85 
service.

As part of the integration, the VLP_LOCATION_LOAD event is associated to the 
SterlingWMS_VLPLocationLoad transport on VLP side. This transport is of the Sterling Local XML 

Sterling Warehouse 
Management System Data

VLP Data

Node Warehouseid

CheckDigit Zoneid

ZoneId Zonedescription

MixSKU Filler
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Reader transport type. The following figure shows the SterlingWMS_VLPLocationLoad transport 
associated to the VLP_LOCATION_LOAD event.

The following figure shows the registration of the VLP_LOCATION_LOAD event with the 
SterlingWMS_VLPLocationLoad transport.

The following table represents attribute mapping for location data between the Sterling Warehouse 
Management System and VLP.

Sterling Warehouse 
Management System Data

VLP Data

LocationId Locationid

CheckDigit Filler

Zone/@CheckDigit Filler1

Node Filler2

AisleNumber Filler3

BayNumber Filler4

LevelNumber Filler5
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Task Type Data Upload Service
The transfer of data pertaining to task types from the Sterling Warehouse Management System to VLP is 
accomplished by two services - one on the Sterling Warehouse Management System side, and the other on 
VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box 
YNW_TaskTypeDataExporter_85 service to upload data pertaining to task type into a shared folder, as 
shown in the following image.

VLP Event

VLP has provided an out-of-the-box VLP_WORKTYPE_LOAD event in order to import data pertaining to 
the task type from the common file. This inbound asynchronous event is also referred to as Import Work 
Type. This event is used to read the XML files uploaded to the common folder by the YNW_ 
TaskTypeDataExporter_85 service.

As part of the integration, the VLP_WORKTYPE_LOAD event is associated to the 
SterlingWMS_VLPWorkTypeLoad transport on the VLP side. This transport is of the Sterling Local XML 
Reader transport type. The following figure shows the SterlingWMS_VLPWorkTypeLoad transport 
associated to the VLP_WORKTYPE_LOAD event.
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The following figure shows the registration of the VLP_WORKTYPE_LOAD event with the 
SterlingWMS_VLPWorkTypeLoad transport.

The following table represents attribute mapping for task type data between the Sterling Warehouse 
Management System and VLP.

Equipment Data Load Service
The transfer of data pertaining to equipments from the Sterling Warehouse Management System to VLP is 
accomplished by two services - one on the Sterling Warehouse Management System side, and the other on 
VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box 
YNW_EquipmentDataExporter_85 service to upload data pertaining to equipments into a shared folder, as 
shown in the following image.

 

VLP Event

VLP has provided an out-of-the-box VLP_EQUIPMENT_LOAD event in order to import data pertaining 
to equipments from the common file. This inbound asynchronous event is also referred to as Import 
Equipment. This event is used to read the XML files uploaded to the common folder by the YNW_ 
EquipmentDataExporter_85 service.

As part of the integration, the VLP_EQUIPMENT_LOAD event is associated to the 
SterlingWMS_VLPEquipmentLoad transport on the VLP side. This transport is of the Sterling Local XML 

Sterling Warehouse 
Management System Data

VLP Data

TaskType Worktypeid

TaskTypeName Worktypedesc
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Reader transport type. The following figure shows the SterlingWMS_VLPEquipmentLoad transport 
associated to the VLP_EQUIPMENT_LOAD event.

The following figure shows the registration of the VLP_EQUIPMENT_LOAD event with the 
SterlingWMS_VLPEquipmentLoad transport.

The following table represents attribute mapping for equipment data between the Sterling Warehouse 
Management System and VLP.

Sterling Warehouse 
Management System Data

VLP Data

CheckDigit Equipmentid

EquipmentId Equipmentpromptdescription

EquipmentType/@Description Equipmentdisplaydescription

EquipmentType/@EquipmentType Equipmenttype

Node Filler
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Execution Exception Data Load Service
The transfer of data pertaining to execution exception from the Sterling Warehouse Management System to 
VLP is accomplished by two services - one on the Sterling Warehouse Management System side, and the 
other on VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box YNW_ReasonDataExporter_85 
service to upload data pertaining to execution exception into a shared folder, as shown in the following 
image.
 

VLP Event

VLP has provided an out-of-the-box VLP_REASON_LOAD event in order to import data pertaining to the 
execution exception data from the common file. This inbound asynchronous event is also referred to as 
Import Reason. This event is used to read the XML files uploaded to the common folder by the YNW_ 
ReasonDataExporter_85 service.

As part of the integration, the VLP_ REASON _LOAD event is associated to the 
SterlingWMS_VLPReasonCode transport on the VLP side. This transport is of the Sterling Local XML 
Reader transport type. The following figure shows the SterlingWMS_VLPReasonCode transport associated 
to the VLP_REASON_LOAD event.
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The following figure shows the registration of the VLP_ REASON _LOAD event with the 
SterlingWMS_VLPReasonCode transport.

The following table represents attribute mapping for execution exception data between the Sterling 
Warehouse Management System and VLP.

Item Data Load Service
The transfer of data pertaining to items from the Sterling Warehouse Management System to VLP is 
accomplished by two services - one on the Sterling Warehouse Management System side, and the other on 
VLP side.

Sterling Warehouse Management System Data Upload Service

The Sterling Warehouse Management System provides an out-of-the-box YNW_ItemDataExporter_85 
service to upload data pertaining to items into a shared folder, as shown in the following image.

 

VLP Event

VLP has provided an out-of-the-box VLP_PRODUCT_LOAD event in order to import data pertaining to 
the items from the common file. This inbound asynchronous event is also referred to as Import Product. This 
event is used to read the XML files uploaded to the common folder by the YNW_ 
ItemDataExporter_version service.

As part of the integration, the VLP_PRODUCT_LOAD event is associated to the 
SterlingWMS_VLPProductLoad transport on the VLP side. This transport is of the Sterling Local XML 
Reader transport type.

Sterling Warehouse 
Management System Data

VLP Data

CheckDigit Reasonid

ExceptionCode Reasondesc
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The following figure shows the SterlingWMS_VLPProductLoad transport associated to the 
VLP_PRODUCT_LOAD event.

The following figure shows the registration of the VLP_PRODUCT_LOAD event with the 
SterlingWMS_VLPProductLoad transport.

The following table represents attribute mapping for item data between the Sterling Warehouse 
Management System and VLP.

Sterling Warehouse 
Management System Data

VLP Data

ItemID Productid

Description Productdisplaydescription
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ShortDescription Productpromptdescription
Notes: 

During picking, the short description of an item is prompted to the picker as a 
voice prompt to enable the picker to identify the item that must be picked 
from the pick location. The Sterling Warehouse Management System relies 
on the TTS (Text To Speech) engine to render the short description of the 
item from text to speech. The TTS engine has limitations in rendering special 
characters such as #, &, and so forth. Therefore, it is recommended to define 
the short description of an item in a format that is easily understood by the 
TTS engine (without the use of special characters).

Ensure that the short description for an item in the Sterling Warehouse 
Management System is configured to a maximum of 32 characters because 
VLP has a 32-character limit for the Productpromptdescription field.

UnitOfMeasure Defaultuom

UnitHeight Height

UnitLength Length

UnitWidth Width

TagControlFlag, IsSerialTracked, 
TimeSensitive

Specialinstruction

TagAttributes Lotnumber

Sterling Warehouse 
Management System Data

VLP Data
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VoiceLogistics Pro Purge
The transaction records in VoiceLogistics Pro (VLP) can be purged by performing the following 
configuration:

1. Open VoxStudio using the default user name SUPERVISOR and default password voxware. 
2. The VoxStudio user interface is displayed. From the menu bar, navigate to Edit > System Preferences.
3. The System Preferences window is displayed. Select the Pruning tab and set the Database Pruning 

Properties as desired.

Note: The Purge can be invoked by executing the prune.bat batch file from the 
<VOX_HOME>/vlp_core/voxprune_build/bin directory. For more information about pruning, 
refer to the VLP Bookshelf Guide.



Examples of Pick Execution Using VoiceLogistics Pro
The following use cases explain the interaction between a user and the voice system.

Picking a Serial-Tracked Item from one Pallet into Another Pallet
The interaction between a user and the voice system in the form of voice input (VI) and voice prompt (VP) 
respectively, is explained here.

VP: "please sign on by voice or browser"

VI: sign on tech for picking please

VP: validating user. please wait

VP: "say equipment"

VI: equipment 11111 confirm

VP: "say zone"

VI: zone 11 confirm

VP: "say work type"

VI: work type 103 confirm

VP: "say ready to go"

VI: ready to go

VP: "work has arrived assignment 1 1 1 1 2"

VP: "setting up 1 containers for assignment 1 1 1 1 2"

VP: "use containers of type Pallet"

VP: "say container id"

VI: container 8 8 8 8 8 confirm

VP: container 8 8 8 8 8 added

VP: "zone DRY AISLE 1"

VI: confirm action

VP: "BAY 1 LEVEL 2"

VI: check 1 2 confirm

VP: "Pick 3 eaches of 24 piece wheat bread"

VI: got it

VP: "verify inventory"

VI: pallet 54322 confirm

VP: "confirm pallet 5 4 3 2 2"
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VI: yes confirm

VP: "pick 3"

VI: grab 3 confirm

VP: "verify serial 1"

VI: serial 22221 confirm

VP: "verify serial 2"

VI: serial 22222 confirm

VP: "verify serial 3"

VI: serial 22223 confirm

VP: "BAY 1 LEVEL 2"

VI: cut this item

VP: “verify cut item”

VI: cut this item

VP: "confirm completion"

VI: confirm action

VP: "drop 8 8 8 8 8 at DOOR2"

VI: check 12 confirm

VP: assignment 1 1 1 1 2 COMPLETE

VP: "say ready to go"

VI: switch to special menu

VP: "special menu"

VI: log me off

VP: good bye tech

Short Picking Serial-Tracked Items from a Pallet
The interaction between a user and the voice system in the form of voice input (VI) and voice prompt (VP) 
respectively, is explained here.

VP: "please sign on by voice or browser"

VI: sign on tech for picking please

VP: validating user. please wait

VP: "say equipment"

VI: equipment 11111 confirm

VP: "say zone"
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VI: zone 11 confirm

VP: "say work type"

VI: work type 101 confirm

VP: "say ready to go"

VI: ready to go

VP: "work has arrived assignment 1 1 1 1 1"

VP: "zone DRY AISLE 2"

VI: confirm action

VP: "BAY 2 LEVEL 2"

VI: check 12 confirm

VP: "Pick 6 eaches of 24 piece wheat bread"

VI: got it

VP: "verify inventory"

VI: pallet 54322 confirm

VP: "confirm pallet 5 4 3 2 2"

VI: yes confirm

VP: "pick 6"

VI: grab 3 confirm

VP: "verify serial 1"

VI: serial 22221 confirm

VP: "verify serial 2"

VI: serial 22222 confirm

VP: "verify serial 3"

VI: serial 22223 confirm

VP: "item P-SHIRT-S-2"

VI: got it

VP: "verify inventory"

VI: loose confirm

VP: "confirm loose pick"

VI: yes confirm

VP: "pick 3"

VI: short this item

VP: "verify short item"
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VI: short this item

VP: "reason for short"

VI: other reason

VP: "BAY 2 LEVEL 2"

VI: cut this item

VP: “verify cut item”

VI: cut this item

VP: "confirm completion"

VI: confirm action

VP: "drop off at DOOR2"

VI: check 12 confirm

VP: assignment 1 1 1 1 1 SUSPEND

VP: "say ready to go"

VI: switch to special menu

VP: "special menu"

VI: log me off

VP: good bye tech
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Security for Voice Integration
The communication between the Sterling Warehouse Management System and VoiceLogistics Pro (VLP) 
can be made secure by using the CALLBACK Mechanism

CALLBACK Mechanism
A voice user requesting a Sterling Warehouse Management System API is authenticated by the Sterling 
Warehouse Management System, which places a callback request with VLP to verify if the user is logged 
into VLP. The Sterling Warehouse Management System also validates the user by ensuring that the node to 
which the user belongs has voice integration enabled. 

To implement the CALLBACK mechanism, perform the following tasks in any order:

✦ Configure the Voice Application Instance
✦ Configure the yifclient.properties file

Configure the Voice Application Instance
Configure the Voice Application Instance in the Voice Application Details dialog box.

To open the Voice Application Details dialog box, perform the following steps:

1. Launch the Applications Manager. From the menu bar, navigate to Applications > Warehouse 
Management.

2. From the tree in the application rules side panel, click  or double-click Task Management. 

3. The tree is expanded. Click  adjacent to Voice Integration, and double-click Voice Applications. 
4. The Voice Applications panel is displayed. From the list that is displayed in this panel, double-click the 

voice application for which you want to create an instance.
5. The Voice Application Details dialog box is displayed. Click the Voice Application Instance tab. 
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6. In the Voice Application Instance panel, click .

7. The Voice Application Instance Details dialog box is displayed. Configure the Voice Application 
Instance by specifying the values for following parameters provided under the Integration Attributes 
panel:

SecurityPolicy=CALLBACK
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VoxwareServer= http://<VLP hostname>:<VLP portnumber>/ngv/workflow/wmsrequest

Configure the yifclient.properties file
Configure the yifclient.properties file by performing the following tasks:

1. Browse to the folder where the SterlingVoxwareIntegrationPack.zip was unzipped.
2. Open the /resources/yifclient.properties file and set the following values for the 

properties:

yif.apifactory.protocol=HTTP

yif.httpapi.url=http://<hostname>:<portnumber>/smcfs/interop/VoiceInteropHttpServlet
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Note: If you want to bypass the authentication validation, select NONE as the parameter value for the 
SecurityPolicy parameter, as displayed in the following figure. However, note that the API access 
policy will still be applicable.
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Troubleshooting
This topic describes the issue that users may encounter when integrating Sterling Warehouse Management 
System with VoiceLogistics Pro.

Problem

Tasks are not suggested to the users using voice unit even when there are open tasks in the Sterling 
Warehouse Management System.

Cause

The Sterling Warehouse Management System does not prompt users about open tasks under the following 
circumstances: 

✦ No tasks are associated for the work type entered by the user.
✦ Inventory shortage exists at the pick location for the task and the Sterling Warehouse Management 

System could not determine an alternate pick location.
✦ The open pick task cannot be executed by the equipment entered by the user.
✦ If the task is for a specified serial number.
✦ If the task is for a specified tag identifier.
✦ If inventories with multiple ship-by-dates are present at the pick location.
✦ The aisle corresponding to the pick location is already occupied by the maximum number of users 

allowed.
Resolution

✦ Try to change the work type by using the Special Menu option.
✦ Try to change the equipment type by using the Special Menu option.
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